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INTRODUCTION

Dynacam is a cam design and analysis program intended for use by engineers and other 
professionals who are knowledgeable in the art and science of cam design.  It is assumed 
that the user knows how to determine whether a cam design is good or bad and whether 
it is suitable for the application for which it is intended.  The program will calculate the 
kinematic and dynamic data associated with any cam design, but cannot substitute for 
the engineering judgment of the user.  The cam theory and mathematics on which this 
program is based are shown in reference [1].  Please consult it for explanations of the 
theory and mathematics involved.

The authors and publishers are not responsible for any damages that may result 
from the use or misuse of these programs.  

Dynacam is one member of a family of programs by this author that share a com-
mon kernel for the overhead actions such as printing, plotting, etc.  In this manual you 
will sometimes see references such as “these programs will . . .”, which means that these 
features are common to the family.  Dynacam also can generate files for export to several 
of these programs e.g., Fourbar, Sixbar, Slider.  

GENERAL INFORMATION

Hardware Requirements

These programs need a Pentium or better processor.  Dynacam is large and uses sig-
nificant computer resources.  A minimum of 1GB of RAM is desirable.  Dynacam may 
require that all other applications be shut off in order to run in a computer with otherwise 
insufficient memory.  A CD-ROM drive is needed, as is a hard disk drive.  

Operating System Requirements

Dynacam 10 is written in Microsoft Visual Basic 2008 and works on any computer that 
runs Windows XP/Vista/Windows7 

Demonstration Version

The demonstration version of this program is downloadable from  

http://www.designofmachinery.com 
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and allows up to 10 runs over a period of 30 days from first installation.  Certain features 
are disabled in the demonstration version, such as the ability to open or save files, and to 
output cam profile or linkage coordinate data.  It does come with several example files that 
can be opened in the demonstration version.  It also has a few cam profile files that can be 
used to test the process of importing the cam profile to a CAD system such as Solidworks 
or ProEngineer.  Instructions for doing so with those programs are also included in the 
download package.  If you wish to have the fully functional program, you must register 
it and pay the license fee defined on the Registration screen.  

Installing the Software

The install file contains the executable program files plus all necessary Dynamic Link 
Library (DLL) and other ancillary files needed to run the programs.  Run the Dynacam_
Install.exe file to automatically decompress and install all of its files on your hard drive.  
Accept all defaults as presented.  When installed the program name will appear in the 
list under the Start button’s Program menu after installation and can be run from there.  
See the Readme file included with the installation package for information on licensing 
the program.

Note that it can only be installed by an administrator on that computer.  Also for it 
to run properly by a user who does not have administrator privileges, the folder Program 
Files\Design of Machinery\Dynacam10 must have write privileges set for all users.  If 
it is installed under Vista or Windows 7, certain properties must be set on the Dynacam.
exe file.  See the instructions with the install package for details.

Licensing the Software

If you want to buy  a license for the program, click on the “I want to buy it now” but-
ton on the Home screen.  This brings up the Authorization screen as shown in Figure A.  
Please follow the instructions in Figure A and on the Authorization screen.  Be sure to 
back up the license files to external media so you can recover the program from a 
disk crash or reformat.

How to Use This Manual

This manual is intended to be used while running the programs.  To see a screen referred 
to, bring it up within the program to follow its discussion.  

PROGRAM OPERATION

All programs in the set have similar features and operate in a consistent way.  For exam-
ple, all printing and plotting functions are selected from identical screens common to all 
programs.  Opening and saving files are done identically in all programs.  These common 
operations will be discussed in this section independent of the particular program.  Later 
sections will address the unique features and operations of each program.
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Running the Program

At start-up, a splash screen appears that identifies the program name, version, revision 
number, and revision date.  Click the button labeled Start or press the Enter key to run the 
program.  A Disclaimer screen next appears that defines the registered owner and allows 
the printing of a registration form if the software is as yet unregistered.  A registration 
form can be accessed and printed from this screen.

The next screen, the Title screen, allows the input of any user and/or project iden-
tification desired.  This information must be provided to proceed and is used to identify 
all plots and printouts from this program session.  The second box on the Title screen 
allows any desired file name to be supplied for storing data to disk.  This name defaults 
to Model1 and may be changed at this screen and/or when later writing the data to disk.  
The third box allows the typing of a starting design number for the first design.  This 
design number defaults to 1 and is automatically incremented each time you change the 
basic design during this program session.  It is used only to identify plots, data files, and 
printouts so they can be grouped, if necessary, at a later date.  When the Next button on 
the Title screen is clicked, the Home screen becomes available. 

General User Actions Possible and Behavior of the Program  

The program is constructed to allow operation from the keyboard or the mouse or with 
any combination of both input devices.  Selections can be made either with the mouse 
or, if a button is highlighted (showing a dotted square within the button), the Enter key 

Click on this button to create a
text file that encapsulates the

License Code shown.

Open this text file in Word,
Wordpad, or other program and
add your contact information.
Also check the version of the

program you want to buy.
Arrange payment and email the

file to the address shown

When you receive the unlock
code, paste it into the yellow

box and click on Activate
License to register the

program.

Follow the instructions to
back up your license files to
other media.  Be sure to shut

the program down before
copying the license files or

they will be worthless.

FIGURE A

Authorization screen for licensing the program
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will activate the button as if it had been clicked with the mouse.  Text boxes are provided 
where you need to type in data.  These have a yellow background.  Double-clicking on a 
text box will select its contents.  In general, what you type in any text box is not accepted 
until you hit the Enter key or move off that box with the Tab key or the mouse.  This 
allows you to retype or erase with no effect until you leave the text box.  You can move 
between available input fields with the Tab key (and back up with Shift-Tab) on most 
screens.  If you are in doubt as to the order in which to input the data on any screen, try 
using the Tab key, as it will take you to each needed entry field in a sensible order.  You 
can then type or mouse click to input the desired data in that field.  Remember that a yel-
low background means typed input data is expected.  Boxes with a cyan background 
feed information back to you, but will not accept input.  

Other information required from you is selected from drop-down menus or lists.  
These have a white background.  Some lists allow you to type in a value different than 
any provided in the available list of selections.  If you type an inappropriate response, it 
will simply ignore you or choose the closest value to your request.  Typing the first few 
letters of a listed selection will sometimes cause it to be selected.  Double clicking on a 
selectable item in a list will often provide a shortcut and sometimes a help screen.

Leaving a screen  Note that when you enter a screen and begin changing values, 
the new data will only be incorporated in your model if you Calculate on that screen 
and exit with the Next button.  If you have changed values in text boxes but have not yet 
recalculated the model and you exit the screen with the Back button, then the old values 
(not your changed ones) will be preserved and the model will remain unchanged.  Re-
member that the program thinks you changed your mind if you Back out of a screen 
and assumes you do not want to keep any changes made therein.  If you Calculate, 
then the changes are in the model.  When you leave via the Next button the program as-
sumes you are done with that task and updates other necessary information accordingly.

HOME SCREEN

All program actions start and end at the Home screen. It has several pull-down menus and 
buttons (File, Screens, View, Units, Examples, License, User, Help, Preferences, About).  
The View menu allows the home screen to be shown in one of three modes: Full Screen, 
Compact, or Menus Only as shown in Figure 1.  The Screens menu allows access to the 
buttons shown on the Compact and Full Screen modes which is the only access to them 
in Menus Only mode.  

The View menu also allows all screens to be Centered or Floated on opening and can 
force them to be Topmost, or not, as you choose.  The defaults when the program is first 
run are: Home is Full Screen and all other forms are Centered and Topmost.  The Prefer-
ences menu allows these and other choices to be set and remembered when the program 
closes.  It will then wake up on subsequent runs in the preferred modes you previously set.

Units Menu

The Units menu defines several units systems to choose from.  It is your responsibility 
to ensure that the data as input are in some consistent units system.  Units conversion is 
done within the program.  The Units menu selection that you make will convert any data 
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that may already be present on any screen from the current unit system to the selected 
one.  Five unit systems are supported: ips, fps, SI, and two mixed unit versions of SI: 
cm-kg-N-s and mm-kg-N-s.  For the last two, length units are displayed in cm or mm, 
but lengths are converted to m before calculating any parameters that involve dynamic 
equations.  Dynamic calculations are done in pure SI for all three metric systems and in 
English units for the other two.  The Units menu also allows the independent variable for 
calculation to be set to one of: time, degrees, or radians.

Examples 

The Examples pulldown menu on the Home screen provides a number of example cams 
that will demonstrate the program’s capability.  Selecting an example from this menu 
will cause calculation of the cam and open a screen to allow viewing the results.  In some 
cases, you may need to hit a button marked Calculate, or Run on the presented screen to 
see the results.  Examples can also be accessed from a drop-down menu from within the 
input (SVAJ) screen.

(a)  Menus only

FIGURE 1

Home screen in each of its three sizes

(b)  Compact

(c)  Full screen

Screens
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About Menu

The About pulldown menu on the Home screen will display a splash screen containing 
information on the edition and revision of your copy of the program.  The Disclaimer and 
Registration form can also be accessed from this menu.

License Menu

The License pulldown menu on the Home screen gives information on the program’s li-
cense status.  It also allows the license to be transferred to another computer or upgraded 
to obtain additional features.

User Menu

The User pulldown menu on the Home screen gives information on the user name, com-
puter name, filename, and location of saved data.

Preferences Menu

The Preferences pulldown menu on the Home screen lets you set the defaults that will 
obtain when the program opens.  These are saved to a text file in the folder where the 
program file resides.  This file is read each time the program opens and rewritten at your 
request from the Preferences menu. See the Preferences Help File in the program for 
more information.

Help Menu

The Help menus on some screens provide on-line access to this manual as well as specific 
instructions for various functions within the screens.  Help files download from a website 
and run automatically in their own browser window.  An instructional video that runs in 
Windows Media Player or any similar program is also accessible from the help menu on 
the Home screen.  You must be connected to the internet to access the on-line help and 
videos.

Exiting a Program

Choosing either the Quit button or Quit on the File pulldown menu on the Home screen 
will exit the program.  If the current data has not been saved since it was last changed, it 
will prompt you to save the model using an appropriate suffix.  It will ask you to confirm 
that you want to quit.  If you choose yes, the program will terminate and any unsaved data 
will be gone at that point.  Note that the Home screen has a check box at its upper right 
corner that can be used to close the program.  This will close the program immediately 
without asking you to save data or confirm the action.

Creating New, Saving, and Opening Files (File Menu)

The standard Windows functions for creating new files, saving your work to disk, and 
opening a previously saved file are all accessible (in licensed installations) from the pull-
down menu labeled File on each program’s Home screen.  Selecting New from this menu 
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will zero any data you may have already created within the program, but before doing so 
will give warning and prompt you to save the data to disk.

The Save and Save As selections on the File menu prompt you to provide a file name 
and disk location to save your current model data to disk.  The data are saved in a custom 
format and with a three-character suffix unique to the particular program.  You should 
use the recommended suffix on these files as that will allow the program to see them on 
the disk when you want to open them later.  If you forget to add the suffix when saving a 
file, you can still recover the file as described below.

Note that the default settings of the program do not allow a data file to start the 
program running when double-clicked.  The reason for this is that double-clicking on a 
file that is not on the same drive as the program’s executable file will lock up the pro-
gram license.  This is an anomaly of the particular commercial licensing program used.  
This restriction can be overridden on the Preferences screen (use Preferences menu), but 
should not be enabled if users of the program might try to run it from a file on an external 
drive or memory stick.  This is inevitable if the program is used by students in a server 
installation.  If you are a single user on an isolated machine and remember not to double 
click on a data file on your memory stick or external drive, then it will be safe to turn on 
this feature.  If you lock the license, you can restore it from your license backup copies.

Selecting Open from the File menu prompts you to pick a file from those available in 
the disk directory that you choose.  If you do not see any files with the program’s suffix, 
use the pulldown menu within the Open File dialog box to choose Show All Files and 
you will then see them.  They will be read into the program properly with or without the 
suffix in their name as long as they were saved from the same program.  

Copying Screens to Clipboard or Printer (Copy)

Any screen can be copied as a graphic to the clipboard by using the standard Windows 
keyboard combo of Alt-PrintScrn.  It will then be available for pasting into any compatible 
Windows program such as Word or Powerpoint that is running concurrently in Windows 
and print from that program.  This is the recommended approach to printing hard copy.

Exporting Spreadsheet Data

On the Home screen, the File pulldown menu has an Export selection, within which is a 
selection for Spreadsheet.  This choice will generate a tab-delimited text file containing 
all the data calculated in Dynacam.  It is essentially a memory dump.  Data are arranged 
in labeled columns for identification and a header is written that identifies the model 
data.  This file can be opened in Excel.  See the section Exporting Cam Contour Data 
for instructions on exporting a cam profile.  Export/Spreadsheet should not be used for 
that purpose.

Support

Support is available only to licensed users.  Please direct questions about program use or 
problems by emailing norton@designofmachinery.com.
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CREATING A CAM

Initially, only the SVAJ and Quit buttons are active on the Home screen.  Typically, you 
will start a cam design with the SVAJ button, but for a quick look at a cam as drawn by 
the program, one of the examples under the Example pulldown menu can be selected and 
it will draw a cam profile.  If you activate one of these examples, when you return from 
the Cam Profile screen you will find all the other buttons on the Home screen to be active.  
We will address each of these buttons in due course below.

Input Data (SVAJ Button)

Much of the basic data for the cam design is defined on the Input (SVAJ) screen shown 
in Figure 2, which is activated by selecting the SVAJ button on the Home screen.  When 
you open this screen for the first time, it will be nearly blank, with only one segment’s 
row visible.  (Note that the built-in examples can also be accessed from this form at its 
upper right corner.) If you had selected an example cam from the pulldown menu on the 
Home screen, making the Input (SVAJ) screen nonblank, and want to start a new model 
please now select the Clear All button on the Input (SVAJ) screen to zero all the data and 
blank the screen, in order to better follow the presentation below.  We will proceed with 
the explanation as if you were typing your data into an initially blank Input (SVAJ) screen.

If you use the Tab key, it will lead you through the steps needed to input all data as 
indicated by the circled numbers in Figure 2.  On a blank Input screen, Tab first to the Cam 
Omega boxes in the upper left corner (1) and type in the speed of the camshaft in rpm or 
rad/s as you prefer.  Tab again (or mouse click if you prefer) to the Number of Segments 

1

2

3

4

5

Type
these

Select
these

Select
these

Type
these

8 9 10

Click
Calculate
for each
segment

Pull down
for examples

You can
plot or print
each
segment's
data to
inspect
results as
you go

6

7

1

12These can only
be changed in
the Professional
Edition

FIGURE 2

S V A J Input screen for program DYNACAM
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box (2) and type in any number desired between 1 and 24.  That number of rows will 
immediately become visible on the Input screen.  If the Clear on Opening checkbox is 
checked, changing the number of segments will erase all content present in the segment 
rows.  Leaving it unchecked allows one to add or subtract segments while preserving 
existing data.

Tab or click to the Delta Theta pulldown (3) and select one of the offerings on the 
menu.  No other values than those shown may be used.  Next select either Translating or 
Oscillating for the follower motion (4).

Choose either Translating or Oscillating for the follower motion.  Note that the units 
of the Start and End values change from length units for translating followers to degrees 
for oscillating followers.

The Starting Angle box (5) allows any value to be typed to represent the machine 
angle on the timing diagram at which you choose to begin the first segment of your cam, 
i.e., where you choose cam zero.  Unless the timing diagram places machine zero within 
a motion event, this can be left as zero, making cam zero the same as machine zero (the 
default).  If machine zero is within a motion (rise or fall) you cannot start the cam design 
at that point.  Also, you should always place cam zero at the beginning of a motion, not 
at or in a dwell.*

The External Force check box and the Motion/Force option buttons (6) are provided 
for situations in which the cam follower is subjected to a substantial external force during 
operation, such as in a compactor mechanism.  Checking this box temporarily converts 
the cam design program into a force-time function design program in which the shape of 
the force-time (or force-angle) function can be defined as if it were a cam displacement 
function with units of force instead of length.  When calculated, the force data is stored 
for later superposition on the follower’s dynamic forces due to motion.  When External 
Force is checked, a dialog box pops up with information on how to use it.  

Another Tab should put your cursor in the box for the Beta (segment duration angle) 
of segment 1 (7).  Type any desired angle (in degrees).  Successive Tabs will take you 
to each Beta box to type in the desired angles.  The Betas must, of course, sum to 360 
degrees.  If they do not, a warning will appear.

As you continue to Tab (or click your mouse in the appropriate box, if you prefer), 
you will arrive at the boxes for Motion selection (8).  These boxes offer a pulldown selec-
tion of Rise, Fall, Poly, Dwell, and Spline.  You may select from the pull-down menus 
with the mouse, or you can type the first letter of each word to select it.  Rise, Fall,, 
and Dwell have obvious meanings.  The Poly choice indicates that you wish to create a 
customized polynomial function for that segment, and this will later cause a new screen 
to appear on which you will define the order and boundary conditions of your desired 
polynomial function.  The Spline choice indicates that you wish to create a customized 
B-Spline function for that segment, and this will later cause a set of new screens to ap-
pear on which you will define the boundary conditions, order, and knot locations of your 
desired B-Spline function.  

The next set of choices that you will Tab or mouse click to are the Program pull-
downs (9).  These provide a menu of standard cam functions such as Modified Trap-
ezoid, Modified Sine, and Cycloid, as well as a large number of specialized functions as 
described in reference [1].  Also included are portions of functions such as the first and 

	

*  If you intend to do 
any dynamic analysis of 
your follower train within 
Dynacam, AND IF you 
start your motion at a dwell, 
the numerical differential 
equation solver will fail 
to converge because when 
started on a dwell, it cannot 
make any progress with its 
computtions.  If you do not 
intend to do any dynamic 
analysis, shame on you, but 
then you can start the cam 
design at or within a dwell.
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second halves of cycloids and simple harmonics that can be used to assemble piecewise 
continuous functions for special situations.  The standard double-dwell polynomials, 3-4-
5 and 4-5-6-7, as well as a symmetrical single-dwell 3-4-5-6 rise-fall function are pro-
vided as menu picks though they can also be created with a Poly choice and subsequent 
definition of their boundary conditions.

After you have selected the desired Program functions for each segment, you will 
Tab or Click to the Position Start and End boxes (10).  Start in this context refers to the 
beginning displacement position for the follower in the particular segment, and End for 
its final position.  Note that if you selected a translating follower, then the displace-
ment values are defined in length units, but if you chose an oscillating follower, they 
must be in degrees.

You may begin at the “top” or “bottom” of the displacement “hill” as you wish, but 
be aware that for a radial cam, the position values of the follower must be in a range 
from zero  to some positive value over the whole cam.  In other words, you cannot 
include any anticipated base or prime circle radius in these position data.  These 
position values represent the excursion of the so-called S diagram (displacement) of the 
cam and cannot include any prime circle information (which will be input later).  If you 
intend to make a barrel cam or a linear cam, then the requirement that the start 
and end values  include a zero value is no longer applicable and the values can be 
over any range desired. 

As each row’s (segment’s) input data are completed, the Calculate button (11) for 
that row will become enabled.  Clicking on this button will cause that segment’s S V A 
J data to be calculated and stored.  After the Calculate button has been clicked for any 
segment’s row, the Plot and Print buttons for that segment will become available (12).  
Clicking on these buttons will bring up a plot or a printed table of data for S V A J data 
for that segment only.  More detailed plots and printouts can be obtained later from the 
appropriate button on the Home screen.  The plots and prints are enabled at this location to 
allow you to determine the values of boundary conditions as you work your way through 
a piecewise function.

Polynomial Functions

If any of your segments specified a Poly motion, clicking the Calculate button will bring 
up the Boundary Condition screen shown in Figure 3.  The cursor will be in the box 
for Number of Conditions Requested.  Type the number of boundary conditions (BCs) 
desired, which must be between 2 and 50 inclusive.  When you hit Enter (and you must 
hit Enter) the rest of the screen will activate, allowing you to type in the desired values 
of BCs.  Note that the start and end values of position that you typed on the Input (SVAJ) 
screen are already entered in their respective S boundary condition boxes at the beginning 
and end of the segment.  Type your additional end of interval conditions on V, A, J, and P 
as desired.  If you also need some additional BCs within the interval, click or tab to one 
of the boxes in the row labeled Local Theta at the top of the screen and type in the value 
of the angle at which you wish to provide a BC.  That column will activate and you may 
type whatever additional BCs you need.

The box labeled Number of Conditions Selected monitors the BC count, and when it 
matches the Number of Conditions Requested, the Next button becomes available. Note 
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Jerk

Start here

Ping

FIGURE 3

Boundary Condition Input screen for polynomial functions in program DYNACAM—3-4-5-6 single-dwell function shown

that what you type in any (yellow) text box is not accepted until you hit Enter or move 
off that box with the Tab key or the mouse, allowing you to retype or erase with no effect 
until you leave the text box.  (This is generally true throughout the program.)  

Selecting the Next button from the BC screen calculates the coefficients of the poly-
nomial by a Gauss-Jordan reduction method with partial pivoting.  All computations are 
done in double precision for accuracy.  If an inconsistent set of conditions is sent to the 
solver, an error message will appear.  If the solution succeeds, it calculates s v a j for the 
segment.  When finished, it brings up a summary screen that shows the BCs you selected 
and the coefficients of the polynomial equation that resulted as shown in Figure 4.  You 
may at this point want to print this screen to the printer or copy and paste it into another 
document for your records.  You will only be able to reconstruct it later by again defining 
the BCs and recalculating the polynomial.

Spline Functions

If any of your segments specified a Spline motion, clicking the Calc button will bring 
up the same Boundary Condition screen shown in Figure 3 that is used for polynomial 
functions.  These are defined in exactly the same way as described for polynomials in the 
preceding section.  

Once you finish selecting boundary conditions for your spline and hit the Next but-
ton, it takes you to the Spline Function screen shown in Figure 5.  This screen shows 
the current segment, the number of boundary conditions that were selected, and requires 
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Spline function screen with adjustable interior knot locations
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you to choose a spline order between four and the number of boundary conditions previ-
ously selected.  It then displays the total number of spline knots used and the number of 
those available for distribution as interior knots.  It also calculates the spline functions 
and displays their S V A J functions for the default assumption of evenly spaced interior 
knots.  The current locations of the knots (in degrees) are displayed in the right side-bar.

The shape of the spline can be manipulated as described in Chapter 5 of ref. [1] by 
moving the interior knots around.  There are several ways to do this.  One is to select a 
knot with its radio button in the right side-bar and type the angle to which you want to 
move it in its yellow text box.  Alternatively, you may select a knot with its radio button 
and then click the mouse on any one of the SVAJ plots at any location that you want that 
knot to move to.  A shortcut to select a knot is to Shift Click near the knot you want to 
activate and this will select its radio button for you.  Then a Click will move that selected 
knot.  Note that because knots must be in ascending order, it will refuse to violate their 
order if you request an inappropriate knot location.  The plots and extreme values will 
update immediately unless you uncheck the Autocalc On box at upper right.  If you are 
making a large number of knot changes, turning off Autocalc will speed the process by 
suppressing the screen updates.  It may also avoid tripping error messages engendered 
by a poor initial distribution of multiple knots until you can get them more or less where 
you want them before allowing it to recalculate the splines.

The Back button returns you to the Boundary Condition screen if you wish to change 
them.  The Show Splines button will display the basis functions that make up the B-
Splines.  Plot Functions returns to the B-Spline plots.  Next returns you to the Input 
(SVAJ) Screen.

Back to the Input Screen

Completing a polynomial or spline function returns you to the Input (SVAJ) screen.  When 
all segments have been calculated, select the Next button on the Input (SVAJ) screen (per-
haps after copying it to the clipboard and pasting it into a Word file to serve as a record 
of your design).  Selecting Next will bring up the Continuity Check screen as shown in 
Figure 6.  

Continuity Check Screen

The screen in Figure 6 provides a visual check on the continuity of the cam design at the 
segment interfaces.  The values of each function at the beginning and end of each segment 
(i.e., between the segments) are grouped together for easy viewing.  The fundamental 
law of cam design requires that the S, V, and A functions be continuous over the entire 
interval.  This will be true if the boundary values for those functions shown grouped as 
pairs are equal.  If this is not true, then a warning dialog box will appear when the Next 
button is clicked.  It displays any errors between adjacent segments in both absolute 
and percentage terms.  You must decide if any errors indicated are significant or are due 
only to computational round-off error.  The message will give information to make this 
judgment.  If the error is very small, and can be safely ignored, the message will say so.  
Cancel will return you to the Input Data screen to correct the problem and OK will take 
you to the Home screen.
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Continuity check screen

Plotting Data (Plot Button)

The Plot button on the Home screen brings up the Plot screen (Figure 7).  Most variables 
in this program are plotted on Cartesian axes.  The cam profile can also be plotted in 
cylindrical coordinates (a polar plot).

Two arrangements for selecting the functions to be plotted are provided.  One pro-
vides preselected collections of functions as shown in Figure 7, and the other allows 
selection of up to four functions from those available on the pulldown menus as shown 
in Figure 8.  Figures 9 and 10 show other examples of the various plot types available.  
Experiment with the selections of number of functions, plot windows and axes to see the 
variety available.  The plots can be augmented with gridlines, fills, lines denoting the 
cam segments, and circles on the joints between cam segments by using the check boxes 
at upper right of the screen.  Right clicking on the plot area will bring up a menu that 
allows other changes to many plot parameters such as color to be made.  A cursor can be 
turned on at upper right and it will display the coordinates of the functions as the cursor 
is hovered over the plotted line.

  From the Plot screen, you may copy to the clipboard for pasting into another ap-
plication by using Alt-Printscreen.  Next returns you to the Home screen.
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The Plot screen has a collection of preset conbinations of functions to choose from
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FIGURE 8

An example of four plots in separate windows and individual dropdown menus to choose plot items
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An example of superimposed plots in multiple windows with multiple axes per window
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Polar plot of the cam profile
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Printing to Screen and Disk Files (Print Button)

Selecting the Print button from the Home screen will open the Print Screen (see Figure 
11) containing lists of variables that may be printed.  A drop-down menu at the top right 
of this screen can be used to direct the printed output to Screen or Disk.  This choice 
defaults to Screen and so must be clicked each time the screen is opened to obtain either 
of the other options.  

Selecting Screen will result in a scrollable screen window full of the requested data.  
Scrolling will allow you to view all data requested serially.  This data screen can be copied 
to the clipboard, but this clip or dump will typically show only a portion of the available 
data, i.e., one screen-full.

Selecting Disk as the output device will cause your selections to be sent to the file 
of your choice in a tab delimited ASCII text format that can be opened in a spreadsheet 
program such as Excel.  You can then do further calculations or plotting of data within 
the spreadsheet program.

The Print screen has two modes for data selection.  One provides preselected sets 
of two or four variables for printing.  Drop-down menus at the top of the screen allow 
selection of up to four calculated variables for printing.  You can print one, two, or four 
variables at a time in either mode.  You can also select other ancillary parameters such as 
the number of decimal places and the frequency of data to be printed.

– or –
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Choose
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functions to
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Select
individual
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Choose print
destination
here

FIGURE 11

The Print  Screen
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Creating the Cam Profile

Once the S V A J functions have been defined to your satisfaction, it remains to size the 
cam and determine its pressure angles and radii of curvature.  This is done from the Profile 
screen shown in Figure 12, which is accessible from the button of the same name on the 
Home screen.  The Profile screen allows the cam rotation direction and follower type (flat 
or roller) to be set.  The cam type (radial, barrel, or linear) and follower motion (translat-
ing or oscillating) can also be selected.  The cam start angle (cam zero) as chosen on the 
S V A J screen is shown and a drop down box allows the keyway location versus machine 
zero to be selected among four cardinal positions.

The prime circle radius, (base circle for a flat follower), roller radius (if any), and 
cutter radius can be typed into their respective boxes.  For a translating follower, its offset 
and angle of translation versus the positive x-axis can be specified.  For an oscillating fol-
lower, the location of the arm pivot and the length and rotation direction of the arm must 
be provided.  When a change is made to any of these parameters, the schematic image of 
cam and follower is updated.  

Select the Calculate button to compute the cam size parameters and the cam contour.  
The max and min pressure angles and radii of curvature are shown at bottom right and 
a more detailed summary can be seen by using the Details button.  Radial cams can be 
animated but barrel and linear cams are displayed statically.  

In a radial cam profile drawing, an arrow indicates the direction of cam rotation.  The 
initial position of a translating roller follower at cam angle θ = 0 is shown as a filled circle 
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Cam and
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FIGURE 12

The cam profile screen



ROBERT L. NORTON ⇠

with rectangular stem, and of a flat-faced follower as a filled rectangle.  Any eccentricity 
shows as a shift up or down of the roller follower with respect to the X axis through the 
cam center.  The smallest circle on the cam centerline represents the camshaft, and its 
keyway is shown as a solid red dot.  The larger circle is the base circle.  The prime circle 
is not drawn.  

The default image of a radial cam shows the inner cam surface.  Check boxes on the 
left allow the inner or outer surface to be displayed.  Check boxes at the top select the 
cam surface, follower path, or the cutter path around the cam  When the follower path is 
shown, the pitch curve is drawn through the locus of the roller follower centers.  

The check box labeled Zero Reference phase-shifts the cam contour to either cam 
zero or machine zero and redisplays it.  In the case of an oscillating arm follower, the cam 
contour is reoriented to put the keyway at the selected o’clock position.  For a translating 
follower, the follower is kept in a fixed orientation along the x axis and the keyway rotated 
to the correct relative position.  These phase shifts incorporate the start angle, follower 
angle, and keyway location.  

The magenta radial lines that form pieces of pie within the base circle represent the 
segments of the cam.  If the cam turns counterclockwise, the radial lines are numbered 
clockwise around the circumference and vice versa.  

The cam profile is now ready for export.  Whether the Primary or Conjugate radio 
button was selected when Next was clicked determines which of those two cam contours 
will be the one exported.  So to generate profile data for a pair of conjugate cams requires 
sequential calculation and export of their respective data to separate files.  The state of the 
Cam Surface radio buttons at the time Next was clicked also dictates which cam surface 
will be exported.  Generating both cam surfaces also requires sequential calculation and 
export of data.  Only one set of cam surface contour data is stored in memory at a time.

The cam profile for a radial cam can be displayed at any time from the Home screen 
with the Profile button.  So, for creation of multiple cam surfaces or conjugates of radial 
cams, it is necessary to revisit the Profile screen.  Clicking Next on the Profile screen re-
turns you to the Home Screen where a dialog box appears with instructions on exporting 
the cam contour data for manufacturing.

Exporting Cam Contour Data

There is more than one way to get the cam contour data out of Dynacam for manu-
facturing, but only one of these is set up specifically for that purpose, and it is strongly 
recommended that you use it in order to avoid errors in manufacturing.  On the Home 
screen, the File pulldown menu has an Export selection, within which are selections for 
Spreadsheet and Profile.  

File/Export /Profile is the recommended choice.  Depending on the type of cam 
designed (radial, barrel, or linear) and the type of follower (roller or flat), the selections 
under Profile will vary.  They typically will provide one or several choices that may 
include surface coordinates, cutter centerline, and roller follower centerline coordinates 
as appropriate.  These data can be output as referenced to cam zero or to machine zero, 
as desired. If these two angles differ it is probably because machine zero is within a mo-
tion segment of the cam.  In that case, one should NOT begin cutting the cam contour at 
machine zero which is within a motion.  However, if one is importing the profile data to 
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a CAD model, then machine zero is probably the better choice for export in order to get 
it properly phased with other cams in the system.

The data exported for radial cams is only provided in cartesian coordinates in order 
to avoid confusion and possible error by the manufacturer that could occur if they were 
given polar coordinates, especially for oscillating followers or for translating followers 
with offsets.  For compatibility with 3-D CAD/CAM systems, three coordinates are pro-
vided, x, y, and z, with z set to zero for radial cams.  The z column is easily deleted in a 
spreadsheet if not needed.*  

The exported data for barrel and linear cams is in 3-D cylindrical coordinates, R, λ, 
z, with R set to a constant value equal to the prime cylinder radius; λ is the cam angle for 
each data point and will not be equispaced for oscillating arm followers or for surface 
data of any cam, and z is the axial follower displacement at R, λ.*

If you insist on being ornery and want to have your cam cutter data in some other 
form, choose the Spreadsheet option and you will get every piece of data that Dynacam 
has calculated for this cam.  But don’t complain when you pick the wrong columns of 
data to give to the shop and your cam doesn’t work!

ANALYSIS

Kinetostatic Analysis

When the cam has been sized, the Dynamics button on the Home screen will become 
available.  This button brings up the Dynamics screen shown in Figure 13.  Text boxes 
are provided for typing in values of the effective mass of the follower system, the ef-
fective spring constant and spring preload for a force-closed follower, and a damping 
factor.  By effective mass is meant the mass of the entire follower system as reflected 
back to the cam-follower roller centerline or cam contact point as defined in Chapter 8 of 
reference [1].  Any link ratios between the cam-follower and any physical masses must 
be accounted for in calculating the effective mass.  Likewise the effective spring in the 
system must be reflected back to the follower.  The damping is defined by the damping 
ratio ζ, as defined for second-order vibrating systems.  See Chapters 8 and 9 of reference 
[1] for further information.  

The journal diameter and the coefficients of friction are used for calculating the fric-
tion torque on the shaft.  The Start New or Accumulate switch allows you to either make a 
fresh torque calculation or accumulate the torques for several cams running on a common 
shaft.  The energy information in the window can be used to calculate a flywheel needed 
for any coefficient of fluctuation chosen as described in Chapter 9 of reference [1].  The 
program calculates a smoothed torque function by multiplying the raw camshaft torque 
by the coefficient of fluctuation specified in the box at lower right of the screen. 

Dynamic Analysis 

True dynamic vibration analysis, as described in Chapter 10 of reference [1], is available 
from the Vibration button on the Home screen once the kinetostatic calculation has been 
done.  This brings up the Model Type selection screen shown in Figure 14.  Four dynamic 
models of the types described in Chapter 10 of reference [1] are available from this screen.  

	

*  Some CAD programs 
require cam profile data 
to “complete the circle,” 
which requires that the data 
repeat the first (zero deg) 
point as the last (360 deg) 
data point.  This requires 
361 data sets for 1-deg 
increments.  Other CAD 
systems want to “complete 
the circle” themselves and 
require the data to stop 
short of the last point.  This 
requires 360 data sets for 
1-deg increments. This 
mode can be set in the 
program to match the CAD 
system of choice by using 
the Help/Preferences panel 
on the Home screen.
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A fifth model for the case of a form closed follower train is also provided, but is directly 
invoked without passing through this screen when form closure has been selected on the 
Dynamics screen.

Each model diagram has an Help button that will display a message describing its 
purpose and application.  Either selecting the model’s radio button and hitting Next, or 
double-clicking on the image of the desired model will take you to the next screen.

Figure 15 shows the Vibration screen for the 1-DOF model of an industrial cam-
follower system.  Text boxes are provided for the input of the relevant effective mass and 
effective spring data, along with assumed levels of damping.  

The box at lower left provides control over the parameters for the 4th-order adaptive 
step Runge-Kutta ODE solver.  It is suggested that these be left at their default values.  
The end time’s value defaults to, and cannot be set to less than, two cycles of the camshaft, 
but can be set longer.  Thus, the calculation solves for at least 2 cam �x evol ��x tions and 
displays the results in plots of displacement error, s–x, x, , and  along with their extreme 
values.  The data is saved only for the second revolution in order to discard the effects of 
any numerical convergence start-up transients.  The center bar shows calculated values of 
the system natural frequencies, natural periods and various dynamic ratios, as described 
in  of reference [1].  Clicking the Next button at this point returns you to the Home screen.

Polydyne and Splinedyne Calculation  The Vibration screen provides a check 
box to make a polydyne or splinedyne cam of the current design.  Checking it brings up a 

Mass reflected
to follower

From a
piecewise
integration of
the torque
curve at left

For friction
torque

calculation

0 < value < 1
to generate
flywheel
torque curve

Spring reflected
to follower

Assumed value

Select type of joint closure

Calculated
values

Must select Ext Force on SVAJ screen for this

Follower force

Camshaft torque

Calculated value

FIGURE 13

Dynamics screen in program DYNACAM
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dialog box with some instructional information.  Proceeding causes the follower dynamics 
to be recomputed as a polydyne or splinedyne function.  The dynamic plots are updated 
and should show marked improvement in their dynamic behavior. 

 Clicking the Next button at this point brings up the Profile screen in order to recalcu-
late the cam contour coordinates with the polydyne or splinedyne modifications.  Retain 
the existing values on this and the next screen, and click on Next until you are back at the 
Home screen.  The cam contour data now awaiting export is that of the polydyne or spline-
dyne cam, though the original nonpolydyne contour has been saved in another location so 
that comparison plots and printouts can be made from the Plot and Print menus if desired.

Stress Analysis

The Stress button on the Home screen becomes available only after either a kinetostatic or 
dynamic analysis has been done.  If only the former was done, then the kinetostatic forces 
will be used to calculate the stresses.  If the Vibration button has been exercised, then 
its more accurate dynamic forces are used for the stress calculation instead.  The Stress 
screen is shown in Figure 16.  The material parameters for both cam and follower must be 
supplied but are defaulted to steel for both.  The appropriate algorithm for surface stress 
will be used based on the earlier choice of flat or roller follower, as described in Chapter 
12 of reference [1].  If a roller follower is used, then you must specify it as cylindrical 
or crowned and provide the relevant dimensional information.  A box is provided for the 
input of a follower weight force if applicable.  If an external force function was calculated 
on the S V A J form, then the check box to include it will become available and it can be 
included or excluded from the stress calculation as desired.  

The calculate button creates and displays the maximum normal and maximum shear 
stress in cam and follower at each point around the cam and also shows the dynamic force 
and cam radius of curvature used in the calculation.  Next returns you to the Home screen.

Fourier Transform (FFT)

The Fourier transform of any function calculated within Dynacam can be formed by 
pulling down the menu labeled FFT on the Home screen.  Figure 17 shows the Fourier 
Transform screen.  Any one cam segment or the entire cam can be selected for transforma-
tion from the upper drop-down menu.  The middle drop-down menu allows any calculated 
follower function to be chosen for transformation.  The lower drop-down menu chooses 
the number of harmonics desired in the Fourier spectrum.  The RMS Sum and the Spectral 
Power are displayed in the right side-bar.  Once a Fourier calculation is done, the spectral 
information for the chosen follower function will be available for plotting, printing, and 
export from those Home screen buttons.  This FFT data can be used to recreate the func-
tions from the Fourier series harmonics as continuous functions of time in an equation 
solver, for example.

LINKAGES

Dynacam allows four types of linkage follower trains to be created, Fourbar linkage, 
Sixbar linkage, Fourbar slider and Sixbar slider as shown in Figure 18.  There are samples 
of each linkage on the Examples menu (Home screen) and these can be used to seed your 
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model and give you a set of compatible links to start with.  The cam’s SVAJ functions 
can be applied either to the input link of the linkage (the arm carrying the roller) or to the 
output end of the linkage (the end effector).  In the latter case, the cam contour will be 
modified to account for distortion caused by the linkage geometry.

The geometry of the follower arm as defined on the Profile screen is automatically 
imported to all linkage screens thus defining the location of link two’s ground pivot versus 
the cam center.  The global coordinate system origin is at the cam center in all cases and 
the orientation is as previously defined on the Profile screen.

Dynacam does only a kinematic analysis of the linkage train, calculating only an-
gular displacements, velocities and accelerations of all the links. These can be plotted in 
Dynacam.  Mass properties of the links can be entered on a separate screen but these are 
not used for dynamic calculations in this program.  They are used only for the lumped 
model approximations on the Dynamics and Vibration screens.  Rather, the linkage ge-
ometry and mass data along with all the cam SVA data can be exported in a text file that 
in turn can be imported into a linkage analysis program such as Fourbar, Sixbar, or 
Slider for further analysis.  Those programs will do a complete kinematic and dynamic 
analysis of the linkage using the SVA cam functions from Dynacam to drive it.

Fourbar Linkage Follower Train

Figure 19 shows the input screen for a fourbar linkage.  The Fourbar Mode defines the 
kinematic circuit of the linkage which can be either open or crossed as desired.  For a 
definition of these terms see reference 2.  The “Angle from Line of Link 2 to Roller Arm” 
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Fourbar linkage

Sixbar slider
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FIGURE 18

Linkage Type selection screen in Dynacam
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parameter defines the included angle between the kinematic link 2 and the arm radius to 
the roller.  This is often zero, but can be nonzero if desired as shown in the figure.  The 
link lengths are always defined as the pin-to-pin distances of each link.  Link numbering 
is standardized with link 1 always the ground link, link 2 the link directly driven by the 
cam and pivoted to ground, link 3 a floating coupler or connecting rod, and link 4 the 
output link in this case, pivoted to ground.  Ground pivots are labeled On with n = link 
number.  The coordinates of pivot O4 must be supplied in the  cam XY coordinate system.

Note that is possible to input a set of linkage data that is impossible to solve as the 
links may not be able to connect if their lengths are not compatible.  An error message 
will appear when the calculation is done if this is the case.  Once calculated, the linkage 
can be animated by using the Run or Step buttons or by dragging the slider bar at the 
bottom of the screen to left or right.  The Mass Prop button goes to the Mass Properties 
screen described below.

Fourbar Slider Follower Train

Figure 20 shows the input screen for a fourbar slider linkage.  The Fourslide Mode defines 
the kinematic circuit of the linkage which can be either open or crossed as desired.  For 
a definition of these terms see reference 2.  The “Angle from Line of Link 2 to Roller 
Arm” parameter defines the included angle between the kinematic link 2 and the arm ra-
dius to the roller.  The link lengths are always defined as the pin-to-pin distances of each 
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Input Data screen for a Fourbar Linkage cam-follower train
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link.  Link numbering is standardized with link 1 always the ground link, link 2 the link 
directly driven by the cam and pivoted to ground, link 3 a floating coupler or connecting 
rod, and link 4 the output slider in this case, running against ground.  The Offset is the 
perpendicular distance between the axis of sliding and the pivot O2.  The Slider Angle is 
the angle between the global X axis and the axis of sliding.

Note that is possible to input a set of linkage data that is impossible to solve as the 
links may not be able to connect if their lengths are not compatible.  An error message 
will appear when the calculation is done if this is the case.  Once calculated, the linkage 
can be animated by using the Step button to advance it one cam increment at a time or by 
dragging the slider bar at the bottom of the screen to left or right.  The Mass Prop button 
goes to the Mass Properties screen described below.

Sixbar Linkage Follower Train

Figure 21 shows the sixbar linkage screen .  The Stage 1 and Stage 2  Modes define the 
kinematic circuits of each stage of the linkage, which can independently be either open or 
crossed.  For a definition of these terms see reference 2.  The “Angle from Line of Link 2 
to Roller Arm” parameter defines the included angle between the kinematic link 2 and the 
arm radius to the roller.  The link lengths are always defined as the pin-to-pin distances of 
each link.  Link numbering is standardized with link 1 always the ground link, link 2 the 
link directly driven by the cam and pivoted to ground, link 3 a floating coupler or con-
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FIGURE 20

Input Data screen for a Fourbar Slider cam-follower train
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necting rod, link 4 a rocker pivoted to ground at O4 that connects the two couplers, link 
5 the second coupler, and link 6 the output rocker, pivoted to ground at O6.  The global 
coordinates of both O4 and O6 must be defined in the cam XY coordinate system.  Link 
4 has two branches, the one labeled 4 and shown in black that connects link 3 to O4, and 
the one labeled 4a in color that connects O4 to link 5 at I45.  The angle between branches 
4 and 4a (which are part of the same link) must be defined also.

It is possible to input a set of linkage data that is impossible to solve as the links 
may not be able to connect if their lengths are not compatible.  An error message will 
appear when the calculation is done if this is the case.  Once calculated, the linkage can 
be animated by using the Step or Run buttons or by dragging the slider bar at the bottom 
of the screen to left or right.  The Mass Prop button goes to the Mass Properties screen 
described below.

Sixbar Slider Follower Train

Figure 22 shows the input screen for a sixbar slider linkage.  The Linkage Modes define 
the kinematic circuits of each stage of the linkage which can independently be either open 
or crossed.  For a definition of these terms see reference 2.  The “Angle from Line of Link 
2 to Roller Arm” parameter defines the included angle between the kinematic link 2 and 
the arm radius to the roller.  Link lengths are defined as the pin-to-pin distances of each 
link.  Link 1 is  the ground link, link 2 the link directly driven by the cam and pivoted to 
ground, link 3 a floating coupler, link 4 a rocker pivoted to ground at O4 that connects 
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the two couplers, link 5 the second coupler, and link 6 the output slider, running against 
ground.  The global coordinates of O4 must be defined in the cam XY coordinate system.  
Link 4 has two branches, the one labeled 4 and shown in black that connects link 3 to 
O4, and the one labeled 4a in color that connects O4 to link 5 at I45.  The angle between 
branches 4 and 4a (which are part of the same link) must be defined.  Offset is the per-
pendicular distance between the axis of sliding and the pivot O2.  The Slider Angle is the 
angle between the global X axis and the axis of sliding.

It is possible to input a set of linkage data that is impossible to solve as the links 
may not be able to connect if their lengths are not compatible.  An error message will 
appear when the calculation is done if this is the case.  Once calculated, the linkage can 
be animated by using the Run or Step buttons or by dragging the slider bar at the bottom 
of the screen to left or right.  The Mass Prop button goes to the Mass Properties screen 
described below.

Mass Properties Screen

Figure 23 shows the Mass Properties screen.  The CG locations and mass properties of 
each link may be entered here.  Proper units must be used.  The stiffness parameters for 
each link can also be entered.  When calculated, this screen will compute the effective 
mass and effective spring values for the dynamic models in the program,  these data will 
be automatically transferred to those screens.  The raw data will be exported to the linkage 
files for import to other programs.

Link lengths
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Link length

Current angle

Drag the slider to move the linkage
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FIGURE 22

Input Data screen for a Sixbar Slider cam-follower train
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IMPORTING MEASURED CAM DATA

Sometimes one needs to reverse engineer an existing cam for which there may be no data 
available on its design or mathematical functions.  If a cam profile has been measured with 
reasonable accuracy, those data can be imported to Dynacam and it will fit an interpolat-
ing function to approximate the cam’s displacement, velocity and acceleration functions.  
Figure 24 shows the Import screen.  Instructions are available from the Help menu on the 
screen.  In brief, the measured data must be in R-Theta coordinates and can be at any uni-
form angular increments.  The data must be placed in a text file, one pair of tab-separated 
R-theta numbers per line.  Dynacam will determine how many pairs are in the set when 
reading the data.  There should not be any header information in the file, just data.

Three interpolation methods are provided, cubic spline, cubic spline with Lanzcos 
smoothing, and Fourier series.  The cubic spline methods are preferable if dwells are 
present because the Fourier series will add ripple to dwells.  But the Fourier method may 
do a better job of smoothing noisy data.

The desired angular increment at which the interpolation is to be done should be se-
lected from the drop-down at the left before importing data.  The units system should also 
be preselected.  The Import Data button will open a browser to find the file, import it and 
display the raw contour as an S-diagram in the upper window.  The Fit Functions button 
will do the interpolation.  First the selected function is fitted to the imported data then 
it is differentiated analytically (not numerically) to get velocity and acceleration.  These 
functions are then resampled at the chosen delta theta increment for display and export.

The Show Data button will display the original imported data and the displacement 
function fitted as shown in Figure 24.  The Show Derivatives button will show the veloc-
ity and acceleration functions from the interpolated curve as shown in Figure 25.  Save 
Functions and Exit stores the interpolated functions in the normal locations for Dynacam 
data, making them available for plotting, printing, and further calculation.

Exiting this screen return you to the Home screen where the SVAJ button will be 
grayed out so as to prevent inadvertent overwriting of the imported data.  All other pro-
gram functions can be applied to the interpolated cam functions.

FIGURE 23

Mass Properties screen in Dynacam
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Probably the best way to utilize this feature in Dynacam is to use the interpolated 
derivatives to determine what functions may have been used in the original cam design 
and where the dwells start and stop.  With this information, a new cam can be designed 
using Dynacam’s built-in functions.  This approach will result in a more accurate and 
dynamically superior cam than will using the interpolated functions as is. 

OTHER

All the data calculated at each stage is saved and becomes available for plotting, printing, 
or exporting to disk.  See General Program Operation for information on New, Open, Save, 
Save As, Plot, Print, Units, and Quit functions.

REFERENCES

	 1	 Norton, R. L. Cam Design and Manufacturing Handbook 2ed. Industrial Press: New 
York. 2008. 

	 2	 Norton, R. L. Design of Machinery 4ed. McGraw-Hill: New York. 2008. 
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Import Data screen in Dynacam
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FIGURE 25

Velocity and acceleration of an imported and interpolated function
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Appendix

THE HISTORY OF PROGRAM DYNACAM

I wrote the first version of this program in 1979 when working as a senior engineer at 
Polaroid Corp.  The graphics minicomputer had recently been invented and Polaroid had 
purchased an early example, a Hewlett Packard.  Recognizing that the company needed 
a better means to design cams for their production machines and wanting to learn how to 
program the HP, I wrote an interactive program for cam design and called it ANACAM.

This program was left behind when I went on to teach mechanical engineering at WPI 
in 1981.  WPI had recently purchased five Apple II computers, which were among the 
vanguard of graphics microcomputers just becoming available at the time.  These were 
then the only graphics-capable computers at the school.  The school had a Vax mainframe 
for all general computation, but graphics terminals for it were still in the future.  The 
Apples were sitting unused in a locked classroom and I asked to use them.  To learn how 
to program them and to create teaching tools for kinematics, I rewrote a much reduced 
version of ANACAM on the Apple II and renamed it Dynacam.

The Apple II version was fairly crude, menu driven, memory limited, and slow, but 
it served the purpose as a teaching tool, along with other programs I wrote for student 
use such as Fourbar, Fivebar, Slider, Sixbar, Engine, and Matrix.  Over the next 
decades, computers went through huge changes.  WPI followed the trends, migrating to 
Macintosh, DOS, and Windows in all its gestations (95, 98, 2000, XP, Vista, 7).  Each 
time the school switched computers and operating systems, I was forced to rewrite these 
programs so that students could still use them.  Languages used were Apple Basic, DOS 
Basic, QuickBasic, Visual Basic 4 through 6, and now Visual Studio VB.NET.  

As the program was rewritten, it also grew with the addition of features and capabili-
ties.  Some of these were the result of student projects done at WPI.  Those students are 
credited in the program’s splash screen.  The biggest changes came about as a result of 
a sabbatical done at The Gillette Company in Boston in 1996, where I found a number 
of my former students using their student copy of Dynacam to actually design cams for 
production machines.  Dynacam was a very limited, menu-driven, DOS program at the 
time.  For example, it only handled translating followers and most of Gillette’s cams have 
oscillating followers.  So, I began adding features while working at Gillette on that sab-
batical and took great advantage of interactions with their engineers to define what they 
needed the program to do.  They also served as my beta testers (and still do).  I simultane-
ously rewrote the code from scratch in Visual Basic.  The result was what is now called the 
Professional Edition of Dynacam.  Release 9 became a mature, useful and well-debugged 
program for cam design used by over 70 companies worldwide.

Dynacam 10 is a complete rewrite of release 9 from scratch and retains its feature set 
but has streamlined and more robust code.  The old program had “grown like Topsy” and 
was somewhat convoluted and a bit of a patchwork that had become difficult to maintain.  
The new program is simpler to use with fewer screens and has much improved plotting 
capability.  Suggestions for improvements are always welcome.

Robert L. Norton P.E.  (norton@designofmachinery.com)


